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RESUMO

Este trabalho apresenta o resultado do projeto de pesquisa realizado na área de                       

telecomunicações, tendo como tema a Modernização das aulas de Laboratório de Circuitos                     

Lógicos realizadas no Câmpus São José. A proposta abordou algumas maneiras do ensino e                         

prática de laboratório da matéria em questão. A partir delas, foi realizado um estudo e análise                             

sobre os métodos possíveis, viáveis e mais modernos do ensino de eletrônica digital. O projeto é                             

constituído das seguintes fases: preparação de três métodos de ensino, análises dos pontos                       

positivos e negativos de cada uma das abordagem, criação de roteiros a serem seguidos por                           

alunos voluntários dos cursos de telecomunicações, aplicação de roteiros com os alunos. Foram                       

elaborados dois formulários, um para obter a opinião dos alunos sobre os roteiros realizados por                           

eles, e o outro para obter a opinião dos professores que atuam nas disciplinas foco do projeto. As                                 

respostas dos formulários nos permitem determinar qual método melhor se adequa ao processo                       

de ensino­aprendizagem nesta área de conhecimento, quais os níveis de simplificação,                   

compreensão, além de analisar as facilidades, dificuldade, efetividade e produtividade no ensino.

 Palavras­chave: Circuitos Lógicos, Laboratório prático.
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1 INTRODUÇÃO

Atualmente as disciplinas com foco nos circuitos lógicos e eletrônica digital dos cursos da                         

área de telecomunicações, utilizam nas aulas de laboratório principalmente kits comprados de                     

empresas que oferecem a opção de Protoboards para conectar Circuitos Integrados Comerciais a                       

módulos disponíveis no kit tais como displays, chaves, leds, geradores de Clock, etc. No entanto                           

na eletrônica digital moderna, utiliza­se de dispositivos lógicos programáveis (DLPs), os quais                     

permitem realizar os mesmos experimentos, com uma tecnologia mais avançada e coerente com                       

a utilizada nas empresas da área de Telecomunicações.

A presente proposta, desenvolve um estudo do mercado de DLPs, e kits dos fabricantes                         

que permitem o uso dessa tecnologia nas aulas práticas das disciplinas de circuitos lógicos e                           

eletrônica digital dos cursos superiores e técnicos. Além do estudo, foi avaliada a viabilidade do                           

uso dos ambientes de desenvolvimento disponibilizado pelos fabricantes dos DLPs. Neste                   

contexto também foram propostos alguns experimentos de laboratório piloto, através dos quais os                       

professores e alunos das referidas disciplinas puderam avaliar se o uso dos DLPs pode substituir                           

os antigos kits de Eletrônica Digital no todo ou em parte.
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2 DESENVOLVIMENTO

No início do projeto foi proposto a aplicação prática de alguns circuitos lógicos                       

(contadores), sendo eles aplicados de três métodos de pesquisa: Montagem do circuito em uma                         

matriz real; Montagem do circuito no software Multisim e a partir deste a montagem do circuito em                               

um software que simula uma matriz virtual; Montagem do circuito no software QuartusII, simulação                         

no QSIM e implementação em um kit de desenvolvimento para FGPA.

O objetivo principal dessa prática foi além de projetar e testar os métodos em laboratório,                           

conseguir diagnosticar os possíveis problemas, erros e também dificuldades que poderiam ser                     

encontrados tanto pelos alunos quanto pelos professores em cada uma das etapas de montagem                         

e também de implementação dos circuitos.

Foi definido então que o projeto seria composto por 3 fases:

1 ­ Preparatória;

2 ­ Avaliação pelos alunos;

3 ­ Aplicação do questionário a alunos e professores.

A fase preparatória, consistiu da preparação do experimento através da implementação e                     

documentação de circuitos lógicos pré­selecionados(contadores) utilizando as 3 possibilidades de                 

ensino prático de eletrônica digital já mencionadas. Na 2ª fase os alunos voluntários dos cursos                           

técnicos e superiores da área de telecomunicações realizaram os experimentos de acordo com                       

os 3 métodos indicados, considerando e anotando as dificuldades e facilidades de cada método                         

para compreensão do circuito lógico e obtenção dos resultados solicitados, sendo eles alunos que                         

estão cursando ou que ainda irão cursar as disciplinas alvo deste projeto. Na 3ª fase tanto os                               

alunos voluntários como os professores das disciplinas que envolvem a área desse projeto foram                         

submetidos a um questionário que visou determinar qual dos três métodos pode ser considerado o                           

mais adequado para o processo de ensino­aprendizagem nas aulas de laboratório das disciplinas                       

de circuitos lógicos e eletrônica digital.

A princípio os três métodos de estudos que foram abordados pelo projeto tem                       

características de montagem do circuito lógico parecidas, mas com enfoques de implementação                     

diferentes. Ainda na fase de preparação foi analisado as possíveis facilidades e dificuldades que                         

seriam diagnosticadas pelos alunos e também os problemas que poderiam apontados pelos                     

professores. Sendo elas:

Método 1 – Montagem em matriz de contatos convencional

A montagem na matriz de contatos traz consigo o benefício de uma percepção próxima a                           
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realidade de circuitos discretos implementados através de placas de circuito impresso (PCB –                       

Printed Circuit Board). Esse método aparentemente proporciona ao aluno uma maior segurança,                     

porém o tempo utilizado na montagem é cerca de 35 a 45 minutos. Esse tipo de abordagem em                                 

aulas de laboratório implica na necessidade de uma preparação antecipada do experimento, que                       

envolve desde a compra dos componentes, armazenamento, e preparação dos conjuntos de                     

experiências para as aulas práticas. Além disso, podem ocorrer diversos erros de montagem do                         

circuito, seja devido ao uso de fios inadequados (oxidados, quebrados e até mal descascados),                         

matrizes de contatos com trilhas com funcionamento incorreto, e conexões entre os componentes                       

feitas de forma diferente da desejada. Em uma prática de laboratório, tanto o aluno como o                             

professor também tem uma grande dificuldade de encontrar esses defeitos, devido a grande                       

quantidade de fios, principalmente em circuitos maiores. Erros na alimentação dos circuitos e                       

curto circuitos em saídas de CIs podem danificá­los, dificultando ainda mais a procura pelos erros.                           

Essa procura pode ser simplificada com o uso intensivo de instrumentos de medição como                         

multímetros, ponteiras lógicas, osciloscópios e analisadores de sinais. Um outro aspecto negativo                     

desse método, que deve ser mencionado, é a dificuldade de repetição do experimento pelo aluno                           

como atividade extraclasse.

Método 2 – Simulação em Software

Neste método utiliza­se o software de simulação Multisim que permite realizar a simulação                       

e também utilizar instrumentos de medição de forma simples e amigável. Após a montagem no                           

Multisim, o contador foi implementado em uma matriz de contatos virtual, na qual o processo de                             

conexão dos componentes é mais simples, pois não há componentes danificados, nem fios ou                         

matriz de contato com problemas. Nesse método o tempo utilizado para fazer a conexões é muito                             

menor que no método anterior, apesar da necessidade de primeiro desenhar o circuito                       

esquemático no Multisim. O entendimento do funcionamento do circuito também é melhor, uma                       

vez que se tem a disposição diversos instrumentos de medição. Acrescente­se a vantagem de o                           

aluno poder repetir o experimento quantos vezes desejar em atividade extra­classe, e a facilidade                         

de documentar tanto os resultados finais como os erros ocorridos. Neste caso não há a                           

necessidade de preparação dos conjuntos de componentes, apenas a disponibilização de um                     

laboratório com os softwares necessários.

Método 3 – Projeto, Simulação e Realização em Dispositivo Lógico Programável

Neste método, utilizam­se os softwares Quartus II e QSIM da ALTERA, os quais são                         

utilizados para o projeto, simulação e implementação final de circuitos lógicos em dispositivos                       

lógicos programáveis. Para a sua utilização são necessários além das licenças dos softwares                       
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mencionados acima, a disponibilização do hardware (kit de desenvolvimento DE2­115). Neste                   

projeto, utiliza­se o método de entrada através de diagrama esquemático do Quartus II, utilizando a                           

biblioteca de circuitos comerciais da série 74. O simulador QSIM, disponível no programa                       

universitário da ALTERA, permite visualizar tanto os diagramas de tempo funcionais como os com                         

tempo de propagação, que facilita muito o entendimento do circuito lógico estudado. Considerando                       

todo o tempo necessário para a entrada do diagrama, simulação e programação do                       

DLP(Dispositivo Lógico Programável), o tempo utilizado foi de cerca de 30 minutos. Este método                         

mostrou ser muito efetivo no processo de ensino­aprendizagem, pois o aluno além de desenhar o                           

diagrama do circuito, fazer a simulação funcional e temporal, ainda pode verificar o seu                         

funcionamento em um hardware que é muito utilizado nas implementações atuais de sistemas na                         

área de telecomunicações. A possibilidade de reprodução do experimento em atividade                   

extra­classe pelo aluno nas fases de projeto e simulação é plenamente viável, desde que ele tenha                             

acesso a computadores conectados a rede do IFSC. A interação entre professor e alunos, e                           

alunos com alunos é facilitada por esse método, principalmente a detecção dos erros. O uso de                             

experimentos mais complexos com um número muito maior de CIs é perfeitamente viável, devido                         

ao grande número de elementos lógicos disponíveis no dispositivo FPGA empregado.

2.1 OBJETIVO GERAL

Estudar o mercado e materiais didáticos de DLPs, avaliando custo de kits, software, para a                           

modernização das aulas de Laboratório de Circuitos Lógicos.

Pesquisar novos métodos e novas linhas de ensino, mais atuais e eficientes para a prática                           

de laboratório das disciplinas envolvidas no projeto.

2.1.1 Objetivos Específicos

Compreender as necessidades de alunos e professores quanto o ensino­aprendizagem                   

de eletrônica digital nos cursos da área de Telecomunicações. Oferecendo a eles testes com três                           

métodos de ensino na aula prática de laboratório de digital. A partir daí, tentar absorver opiniões e                               

indicações através de questionários e formulários pré­estabelecidos, tendo o objetivo de visionar                     

qual das opções é a mais adequada e a partir desta, poder oferecer uma nova linha de ensino a                                   

ser seguida por professores, com intuito de modernizar as práticas de laboratório, preparando                       

melhor os alunos para o mercado de trabalho.
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2.2 METODOLOGIA

A metodologia adotada pelo projeto foi a pesquisa inicial e testes de laboratório realizadas                         

para a simulação das dificuldades encontradas em aulas práticas de circuitos lógicos nos três                         

tipos de abordagens apresentadas.

Seguido dos testes com alunos, nesta etapa os alunos voluntários foram submetidos a                       

roteiros envolvendo os métodos já mencionados e tiveram que responder um formulário                     

(disponível em: Formulário Alunos http://bit.ly/Form­MLCL­Alunos), onde a partir dos testes                 

realizados por eles, foi possível chegar ao objetivo principal do projeto, através das respostas,                         

podendo oferecer um novo método de ensino mais modernos e mais compatível com os usados                           

hoje por empresas que atuam na área de telecomunicações.

Professores do Câmpus que lecionam ou já lecionaram as matérias de eletrônica digital,                       

também foram submetidos a um questionário (disponível em: Formulário Professores                 

http://bit.ly/Form­MLCL­Prof) . Para eles foram apresentados os roteiros realizados pelos alunos e                     

a partir daí a pesquisa tentou absorver deles a opinião e também propostas através da experiência                             

com aulas de laboratório, e também qual dos métodos que eles acreditam que o ensino pode ser                               

mais eficaz, quais são os pontos positivos e negativos de ambos, beneficiando a pesquisa, que                           

retrata os dois lados práticos, o de quem ensina e o de quem aprende.

2.3 PROCEDIMENTOS EXPERIMENTAIS

Como procedimentos experimentais foram aplicados aos alunos 3 roteiros para analisar os                     

métodos abordados pelo projeto. Eles foram aplicados aos alunos voluntários dos cursos de                       

telecomunicações do Câmpus. Não foi estipulado limite de tempo para que os alunos                       

desenvolvessem os roteiros, dando a eles bastante liberdade no processo de montagem dos                       

mesmos.

Os roteiros para os testes iniciais com alunos foram criados seguindo um padrão de                         

experimento, todos eles implementaram o mesmo circuito, este escolhido a partir dos que foram                         

pré­realizados em laboratório, sendo selecionado o circuito contador assíncrono crescente de 4                     

bits (ASSINCOUNT4). Foram implementados os três métodos propostos: 1 ­ Montagem e teste do                         

ASSINCOUNT4 em matriz de contatos convencional; 2 ­ Simulação do ASSINCOUNT4 usando o                       

software Multisim seguido da sua montagem em um software que simula uma matriz de contatos                           

virtual; 3 ­ Projeto do ASSINCOUNT4 usando o software Quartus II, seguido da simulação com o                             

software QSIM, e realização do circuito usando o kit de desenvolvimento DE2­115 da TERASIC.                         

Tendo como objetivo principal realizar uma análise desses métodos visando perceber qual deles                       

https://docs.google.com/forms/d/1MqY7fK3WNLTYDxx6EvbCx-YPcB_rtLorMZfW1C7M6Hs/viewform
https://docs.google.com/forms/d/14FiGjL5MbTzzsMguikQpd3Ke01OpH-fLC7nqyyp4UTE/viewform
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facilita o processo ensino­aprendizagem.

A amostragem do circuito cotador também teve um padrão de implementação, nos 3                       

roteiros o circuito contador teve suas saídas distribuídas em uma sequência de leds e também em                             

um display 7­segmentos, mecanismos disponíveis em ambos os métodos abordados afim de não                       

haver diferentes níveis de complexidade entre as abordagens.

Método 1 – Montagem em matriz de contatos convencional

Neste segmento os alunos tiveram que montar o ASSINCOUNT4 em uma matriz de                       

contatos convencional, onde eles puderam aplicar seus conhecimentos básicos de eletrônica                   

digital. Tendo como objetivos principais dessa montagens os seguintes itens:

● Ler e compreender um diagrama esquemático de um circuito contador;

● Montar um circuito contador utilizando uma matriz de contatos real;

● Alimentar o circuito montado e verificar os seu funcionamento;

● Detectar e corrigir eventuais erros;

● Compreender o funcionamento do circuito integrado (CI) comercial ­ 74HC74.

Nesta etapa, puramente funcional o aluno não teve tempo estipulado para a realização do                         

experimento, tendo total liberdade para analisar, conferir, indicar possíveis erros e até mesmo                       

refazer a montagem quando não obteve os resultados esperados, porém não é dessa maneira                         

que ele é aplicado em aula de laboratório, pois nelas eles tem tempo limitado para a montagem                               

dos circuitos.

Método 2 – Simulação em Software

Neste segmento os alunos realizaram primeiramente a simulação do ASSINCOUNT4 no                   

software Multisim, uma alternativa mais consistente para o ensino de digital, pois ele possui                         

diversos atributos que inicia­se com o desenho das ligações entre os flip­flops, tendo uma                         

percepção maior na lógica do circuito contador. Após a montagem no software Multisim, os alunos                           

montaram o ASSINCOUNT4 em um software que simula um matriz de contatos idêntica a usada                           

manualmente, porém virtual. Possuindo a facilidade de separação de componentes, economia de                     

tempo para preparar os fios que seriam utilizados na montagem, além da facilidade do                         

preenchimento da matriz com maior segurança, sem temer a queima de algum dispositivo. Tendo                         

como principais objetivos os seguintes itens:

● Inserir diagrama esquemático de um contador assíncrono com o Multisim.

● Conectar as saídas do contador a um mostrador de 7­segmentos.

● Entender o funcionamento do contador.

● Montar o circuito em uma matriz virtual.
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● Compreender o funcionamento do circuito integrado (CI) comercial ­ 74HC74.

Método 3 – Projeto, Simulação e Realização em Dispositivo Lógico Programável

Neste segmentos os alunos tiveram que montar o ASSINCOUNT4 primeiramente no                   

QuartusII, inciado com um projeto onde foi necessário a inserção do desenho e ligações lógicas já                             

definidas no roteiro, nesta etapa assim como na anterior o entendimento sobre a lógica inserida no                             

circuito é abordada de forma plena, porém, ao simular no QSIM, o entendimento e possibilidades                           

de testes ultrapassam o método anterior, pois o software é composto por diversos atributos que                           

possibilitam uma contribuição muito maior do aluno com o projeto proposto, como por exemplo, os                           

testes do circuitos e a maneira como ele se comporta em estado temporal e estado funcional,                             

abrindo os horizontes dos alunos para uma percepção ainda maior não só do circuito testado ou                             

da montagem que a ser feita, mas também de alguns comportamentos que o circuito contador                           

apresenta em determinadas maneiras que podem ser testadas através desse software de                     

simulação em hardware, o que despertou muitos questionamentos, curiosidades, além da                   

sugestão de alunos sobre outras pesquisas.

Após todos os testes, o circuito projetado foi realizado em hardware através de uma                         

simples transferência do arquivo de configuração “ASSINCOUNT4 .sof”, onde o aluno pode                     

conferir o funcionamento correto do contador, no roteiro proposto foi definido que as saídas do                           

contador seriam em um display 7­segmentos e também em uma das sequências de leds                         

disponível, mas esse Kit dispõe de uma enorme variedades de componentes que podem ser                         

utilizados, como por exemplo a amostragem do contador em um módulo LCD, demostrando as                         

diversas opções que essa abordagem de ensino pode proporcionar, de modo mais moderno com                         

muitas particularidades não encontradas nos demais meios estudados, indo de encontro com os                       

atuais métodos adotados pelas empresas da área.

Os principais objetivos desta etapa são:

● Inserir diagrama esquemático de um circuito lógico com o Quartus II

● Fazer a simulação funcional de um circuito com o QSIM

● Gerar formas de onda para entrada de simulação

● Fazer a simulação temporal de um circuito com o QSIM

● Preparar o circuito lógico para gravação no kit DE2­115

● Verificar os resultados obtidos.

A documentação foi realizada na página wiki do projeto (http://bit.ly/IFSC­PRJ005­2013), na                   

qual o procedimento de montagem dos circuitos é mostrada. A página tem o objetivo de registrar                             

todos os passos do projeto, sendo editada todos os dias e adicionada a ela tudo o que foi realizado                                   

na data indicada, inclusive dúvidas, dificuldades encontradas e definições de futuras propostas.

http://www.google.com/url?q=http%3A%2F%2Fbit.ly%2FIFSC-PRJ005-2013&sa=D&sntz=1&usg=AFQjCNFKd7RmoKC9HNlwepQufZRTjNsNhA
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2.4 RESULTADOS

Os resultados do projeto foram obtidos através dos formulários preenchidos pelos alunos,                     

dezenove ao total, que realizaram os roteiros propostos e também pelos professores da área que                           

puderam opinar a respeito dos roteiros realizados, contribuindo com sua experiência em aulas de                         

laboratório e conhecimento sobre os métodos estudados para uma conclusão plena que pretende                       

beneficiar aluno e professor.

Para os alunos o nível de dificuldade de realização do roteiro do Método 3 é equiparado aos                               

demais roteiros (Montagem em matriz real; Simulação no software Multisim e montagem em                       

matriz virtual;), porém o nível de entendimento sobre o contador nesta etapa foi considerado muito                           

maior do que nas etapas anteriores, demostrando a eficácia desse método, sendo este também o                           

roteiro com maior pontuação no item que questiona em qual dos métodos houve uma maior                           

percepção do funcionamento lógico do circuito implementado.

No entanto, no quesito segurança de implementação do circuitos, foi observado que                     

ocorreu quase um empate nas respostas entre os Métodos 2 e 3. Os alunos sentiram mais                             

confiança e demonstraram menos receio com eventuais falhas no momento da montagem nessas                       

etapas.

Comparando os três métodos abordados, os alunos concluíram que a abordagem mais                     

fácil de introduzir o circuito é com o software Multisim e montagem em matriz virtual, porém aquele                               

que apresentou menos erros durante a montagem foi o Método 3, sendo também considerado o                           

melhor entres os três para encontrar os erros de montagem do circuito lógico. Além disso este                             

método foi considerado a abordagem mais produtiva e interessante entre as três propostas pelos                         

alunos.

A maioria dos alunos considera que na montagem em matriz real que é a mais utilizada                             

nos cursos para o ensino de eletrônica digital, há uma maior interação com o componente real,                             

havendo um contato direto deles com os equipamentos. Porém, muitos quesitos foram expostos                       

negativamente a respeito deste método, como por exemplo, a dificuldade na detecção de erros                         

que as vezes ultrapassa o tempo permitido em sala de aula para a conclusão de montagens.                             

Outro item também muito mencionado nos formulários foi a diferença de conhecimento obtida nas                         

etapas, sendo o primeiro método o que menos contribuiu no processo de entendimento lógico do                           

circuito estudado.

O método de simulação em software obteve boas pontuações nos resultados finais, os                       

alunos o consideraram melhor em alguns pontos, como exemplo o fácil manuseio do software e                           

sua simplicidade de implementação, além do maior conhecimento obtido neste etapa que propõe a                         

montagem do circuito lógico, incluindo também a montagem do circuito lógico em matriz virtual,                         

esta apresentou maior seguridade aos alunos por não haver erros de componentes, de fios mal                           
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conectados, trilhas dos contatos da matriz estragadas e outros componentes que poderiam ter                       

falhas, chegando ao objetivo final do roteiro com maior facilidade que na etapa anterior.

O Projeto simulado e implementado em Dispositivo Lógico Programável foi bem aceito                     

pelos alunos, a maioria deles nunca tinha utilizado o software QuartusII. O nível de complexidade                           

para começar a desenhar os componentes lógicos do circuito no método 3 foi considerado baixo.                           

Foi muito citado pelos alunos a simplicidade na detecção de erros e também a simulação temporal                             

e funcional que proporciona um horizonte de conhecimento muito maior sobre o circuito                       

implementado. Além da modernização das placas com dispositivos FPGAs, no caso o kit utilizado                         

foi a DE2­115 (Anexo B).

Foi realizada também a análise das respostas do formulário direcionado aos professores,                     

quatro ao total, que lecionam ou já lecionaram na área de ensino prático de eletrônica digital e                               

matérias adjacentes a esta responderam aos questionários propostos.

Eles apontam o uso com maior frequência dos kits composto por matrizes reais, sendo                         

este o método com maior disponibilidade de uso nos laboratórios. Alegam que os alunos sentem                           

maior necessidade de manusear o hardware, além e ver seu funcionamento.

Alguns professores relataram a falta de interesse dos alunos em aulas de laboratório com                         

matrizes reais e também em kits DataPool (Anexo A), pois além de cansativo o processo de                             

detecção de erros, a prática se torna muito demorada, demostrando a deficiência deste método                         

de ensino. A desatualização deste método também foi citada pela maioria dos professores, eles                         

questionam que os alunos não saem preparados para o mercado de trabalho e que a prática de                               

ensino convencional representada pelo método 1 está ultrapassada.

Foi perguntado a eles se conheciam e praticavam o uso em suas aulas práticas dos outros                             

métodos abordado por esta pesquisa, grande parte deles conhece, mas não tem experiência na                         

programação de dispositivos lógicos programáveis. Para incentivar o uso do Método 3 é                       

necessário um curso de capacitação em implementação e simulação de circuitos lógicos usando                       

o software Quartus II e os kits de desenvolvimento para FPGAs. Note que todos os professores                             

demonstraram interesse em aplicar essa nova prática de ensino nas aulas de laboratório,                       

moderna e condizente com as práticas atuais de mercado.
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3 CONCLUSÕES E RECOMENDAÇÕES

O intuito principal com a finalização do projeto é que os alunos possam ter uma maior                             

fluência no projeto de sistemas digitais em hardware. Além de despertar a atenção dos                         

professores quanto a novas práticas de ensino e interesse na lógica programável, este por sua                           

vez alcançado já que todos os envolvidos na pesquisa demostraram estar dispostos a aplicar                         

novos métodos de ensino em suas aulas práticas de digital, com isso espera­se que                         

gradativamente as aulas envolvendo matrizes de contato para este fim sejam substituídas pelas                       

técnicas mais modernas e adequadas ao estado da arte em hardware. O uso de DLPs,                           

principalmente dos FPGAs, possibilita o desenvolvimento de projetos tanto acadêmicos como os                     

trabalhos de conclusão de curso (TCC) como de pesquisa aplicada, a um custo muito inferior ao                             

uso de lógica discreta.

Através da análise de resultados obtidos através dos formulários, é possível concluir que a                         

maneira mais eficiente para melhorar e modernizar o ensino da aula prática de eletrônica digital é a                               

aplicação do método 3 (Projeto, Simulação e Realização em Dispositivo Lógico Programável),                     

sendo ele definido como o mais produtivo e que possui diversas funcionalidades específicas que                         

auxiliam e induzem o interesse do aluno na área, proporcionando a eles um amplo conhecimento                           

sobre os projetos que podem ser desenvolvidos através deste método.

Sugerimos que seja dada continuidade a este trabalho, através da implementação de                     

novos roteiros e experimentos segundo o Método 3 (Projeto, Simulação e Realização em                       

Dispositivo Lógico Programável), nos quais as práticas de laboratório disponíveis para os kits                       

convencionais com matrizes de contato serão substituídas por práticas usando os kits de                       

desenvolvimento em lógica programável. Dessa forma os professores das disciplinas alvo deste                     

projeto, poderiam aplicar com maior facilidade a proposta de projeto nas suas aulas de laboratório,                           

modernizando assim o processo de ensino­aprendizagem.
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APÊNDICE A - Contador Assíncrono Crescente. Roteiro para a        

montagem na matriz de contatos real

Objetivos

● Ler e compreender um diagrama esquemático de um circuito contador;

● Montar um circuito contador utilizando uma matriz de contatos real;

● Alimentar o circuito montado e verificar os seu funcionamento;

● Detectar e corrigir eventuais erros;

● Compreender o funcionamento do circuito integrado (CI) comercial ­ 74HC74.

Materiais a serem utilizados

● Componentes necessários para a realização da montagem:

● Kit didático da DataPool Modelo 8810;

● 2 Circuitos Integrados (CI) SN74LS74;

● Fios;

● Alicates;

Montagem na matriz de contatos

● Selecione os componentes necessários para a montagem;

● Insira os CIs 74LS74 na matriz de contato;

http://www.google.com/url?q=http%3A%2F%2Fwww.ti.com%2Flit%2Fds%2Fsymlink%2Fsn54ls74a.pdf&sa=D&sntz=1&usg=AFQjCNExoG9mHKRPQ_2n88N8vBR_dPR2Jw
http://www.google.com/url?q=http%3A%2F%2Fwww.ti.com%2Flit%2Fds%2Fsymlink%2Fsn54ls74a.pdf&sa=D&sntz=1&usg=AFQjCNExoG9mHKRPQ_2n88N8vBR_dPR2Jw
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● Faça as conexões das alimentações VCC e GND, disponível nos contatos +5V e COM no                           

lado direito da matriz;

● Como clock (CLK), utilize o sinal de 1Hz disponível no lado esquerdo da matriz; Conecte o                             

clock também ao led L9;

● Para utilizar o mostrador de 7 segmentos conecte as saídas do contador Q0 a Q3 aos leds                               

L4 a L7 (na parte superior do kit);

● Faça as demais conexões conforme o diagrama esquemático do contador representado na                     

figura a seguir;
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● Confira com atenção as alimentações dos CIs e demais conexões antes de alimentar a                         

matriz de contatos.

● Ligue o kit 8810 através da chave tipo alavanca que se encontra na parte de trás;

● Observe o funcionamento do contador;

● Note que a cada segundo o mostrador deve contar [0, 1, .., 9, A, B, C, D, E e F];

● Para corrigir eventuais erros, sempre desligue primeiro o kit;
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APÊNDICE B - Contador Assíncrono Crescente. Roteiro para       

simulação no MULTISIM e montagem na matriz de contatos virtual         

Objetivos

● Inserir diagrama esquemático de um contador assíncrono com o Multisim.

● Conectar as saídas do contador a um mostrador de 7­segmentos.

● Entender o funcionamento do contador.

● Montar o circuito em uma matriz virtual.

● Compreender o funcionamento do circuito integrado (CI) comercial ­ 74HC74.

Simulação no Multisim

● Abra a máquina virtual WINDOWS no Virtualbox;

● Abra o Multisim (versão demo);

● Insira o diagrama esquemático do contador assíncrono crescente de 4 bits;

● Após a montagem do contador, conecte as suas saídas ao mostrador de 7­segmentos;

Obs.: Utilize os Flip­Flop do CI comercial 74HC74.

● Depois de conferir todas as ligações, alimente o circuito através da chave [I | O];

● Observe o resultado da contagem crescente no mostrador, e anote os resultados.

Montagem na matriz de contatos virtual
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● Utilizando ainda a máquina virtual WINDOWS;

● Abra o software WinBreadBoard;

● Insira o circuito contador na matriz virtual, conforme o diagrama esquemático mostrado                     

anteriormente;

● Para iniciar a montagem é necessário selecionar os CIs utilizados no circuito (Chips >                         

Flips­Flops > 7474 Dual D). Repetindo duas vezes para a implementação de dois CIs;

● Para a montagem verifique o diagrama interno do CI (duplo clique sobre o CI);

● Conecte os pinos de alimentação do CI ao VCC e GND, usando a linha X para o VCC e Y                                     

para o GND. Sugestão, use a cor preta para o GND e vermelha para o VCC;

● Faça as demais ligações conforme o diagrama esquemático introduzido no Multisim;

● Conecte as saídas do contador ao mostrador de 7­segmentos no canto inferior direito;

● Ligue a chave [ON | OFF] e observe a saída no mostrador; Note que o mostrador deve                               

contar [0, 1, .., 9, A, B, C, D, E e F]
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APÊNDICE C - Contador Assíncrono Crescente. Roteiro para       

implementação e simulação com QUARTUS II, QSIM e kit DE2-115

Objetivos
● Inserir diagrama esquemático de um circuito lógico com o Quartus II

● Fazer a simulação funcional de um circuito com o QSIM

● Gerar formas de onda para entrada de simulação

● Fazer a simulação temporal de um circuito com o QSIM

● Preparar o circuito lógico para gravação no kit DE2­115

● Verificar os resultados obtidos.

Diagrama Esquemático

Abra o Quartus II (versão 12.1) e insira o diagrama esquemático de um contador assíncrono                           

crescente com 4 bits, conforme a figura abaixo.

Após salvar o arquivo como cont_up.bdf em uma pasta vazia com nome EX_1, e crie um projeto                               

cont_up.qpf utilizando a família family=Cyclone IV com o dispositivo device=EP4CE115F29C7.                 

Após isso compile o projeto.

Simulação funcional com o QSIM

● Abra o QSIM e abra o arquivo de projeto cont_up.qpf (File > Open Project...).

● Em seguida gere o arquivo de nós do projeto (Processing > Generate Node Finder Files).

● Crie as formas de onda para entrada da simulação (File > New Simulation Input File).

● Defina o tempo de simulação (Edit > Set End Time ...) = 400 ns.

● Importe todos os nós de lista do projeto (Edit > Insert > Insert Node or Bus) > [Node Finder]                                   

> [List] > [>>] > [OK] > [OK].
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● Desenhe a forma de onda dos sinais de entrada conforme mostrado na figura abaixo, e                           

salve com o nome entrada.vwf.

● Indique como a simulação será feita (Assign > Simulation Settings ...). Escolha o arquivo de                           

forma de onda de entrada que você criou (entrada.vwf) e selecione a tipo de simulação [x]                             

Functional.

● Faça a simulação do circuito lógico usando o sinal criado (Processing > Start Simulation)

● Abra o arquivo resultado da simulação (File > Open Simulation Output File). E verifique se o                             

resultado obtido corresponde a um Contador assíncrono Crescente. Salve o sinal de saída                       

como resultadoF1.vwf.

Simulação temporal com o QSIM

● Indique como a simulação será feita (Assign > Simulation Settings ...). Escolha o arquivo de                           

forma de onda de entrada que você criou (entrada.vwf) e selecione a tipo de simulação [x]                             

Timing.

● Faça a simulação do circuito lógico. Abra o arquivo resultado da simulação. Verifique as                         

mudanças que ocorreram nos sinais de saída Q1, Q2, Q3 e Q4. Salve o sinal de saída                               

como resultadoT1.vwf.
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Inserindo um decodificador de 7 segmentos

Para melhor visualizar o resultado da contagem, será usado um decodificador BCD para 7                         

segmentos comercial. Utilize o CI SN7447. Ligue o CI conforme indicado no diagrama                       

esquemático. O resultado no display será uma contagem conforme a figura a seguir:

Preparando para gravar o circuito lógico no FPGA

Para gravar o circuito lógico no FPGA, é necessário escolher um FPGA para a aplicação. Neste                             

caso utilizaremos o kit DE2­115.

● Mude a família e dispositivo a ser usado (Assignments > Devices), [Family = Cyclone IV E]                             

e selecione EP4CE115F29C7.

● Utilize o display HEX0 do kit para mostrar a contagem:

● Utilize os leds de LED0 a LED3 (verdes) para mostrar a contagem em binário.

● Utilize a chave KEY0 para gerar o sinal de CLK.

● Atribua os pinos conforme a pinagem do kit DE2­115.

● Ao final da configuração dos pinos, o Pin Planner deverá mostrar a seguinte pinagem:

http://www.google.com/url?q=http%3A%2F%2Fwww.ti.com%2Flit%2Fds%2Fsymlink%2Fsn7447a.pdf&sa=D&sntz=1&usg=AFQjCNH911_m4_2q9aylpILpkdO9VsvRjA
http://www.google.com/url?q=http%3A%2F%2Fwww.ti.com%2Flit%2Fds%2Fsymlink%2Fsn7447a.pdf&sa=D&sntz=1&usg=AFQjCNH911_m4_2q9aylpILpkdO9VsvRjA
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● Defina como alta impedância o estado dos pinos não utilizados no projeto. (Assignments >                         

Devices), [Device and Pin Options...], escolha a (Category=Unused Pins), e selecione                   

Reserve all unused pins: As input tri­stated. [OK].

● Compile o projeto. Note que agora a numeração dos pinos também aparece no diagrama                         

esquemático.

Gravando o projeto no FPGA

● Use a porta USB­Blaster para fazer a programação na placa DE2­115;

● No Quartus vá em (Tools > Programmer) para abrir a página de programação;

○ Selecione o Hardware (Hardware Setup > USB­Blaster);

○ Utilize o modo JTAG e clique em Start para começar a programação;



Projeto Modernização das aulas de Laboratório de Circuitos Lógicos 24

APÊNDICE D - Formulário Alunos: Modernização das Aulas de        

Laboratório de Circuitos Lógicos

Qual o curso que você está cursando ou já cursou?

Questões sobre a Montagem do circuito em matriz de contatos REAL

Qual o nível de dificuldade no procedimento?
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Qual o nível de conhecimento sobre o contador foi obtido nessa etapa?

Questões sobre a Simulação no Multisim e montagem do circuito em                   

matriz de contatos VIRTUAL

Qual o nível de dificuldade no procedimento?
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Qual o nível de conhecimento sobre o contador foi obtido nessa etapa?

Questões sobre a implementação no Quartus, simulação com QSIM e                 

realização do circuito no kit da ALTERA

Qual o nível de dificuldade no procedimento?
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Qual o nível de conhecimento sobre o contador foi obtido nessa etapa?

Questões de comparação entre as três abordagens

Em qual abordagem houve uma melhor percepção do funcionamento do circuito                   

lógico?
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Em qual abordagem obteve maior segurança na implementação do circuito?

Em qual das abordagens é mais fácil de fazer a montagem do circuito?

Em qual você teve problemas de montagem?
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Em qual das abordagens é mais fácil encontrar erros de montagem?

Em qual abordagem foi mais simples acompanhar o diagrama de tempo do                     

circuito em funcionamento?

Em qual abordagem você se sentiu mais seguro durante a implementação do                     

circuito?
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Qual abordagem foi mais interessante e produtiva?
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APÊNDICE E - Formulário Professores: Modernização das Aulas de        

Laboratório de Circuitos Lógicos

Qual a disciplina que lecionou?

Último ano em que lecionou a disciplina
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Sobre as aulas de laboratórios

Você utiliza(va) aulas de laboratório para ensinar? Com qual frequência?

Sobre a modernização das aulas de laboratórios

Conhece o kit com matriz de contatos REAL?

Você já usou o kit com matriz de contatos REAL em aula?
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Conhece o software Multisim?

Você já usou o software Multisim em aula?

Conhece o simulador de matriz VIRTUAL?
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Você já usou o simulador de matriz VIRTUAL?

Conhece o software QuartusII e QSIM e os kits de desenvolvimento?

Em aula, você já usou o Quartus II junto com o QSIM seguido da

implementação do circuito no kit de desenvolvimento?
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Quais dos três métodos é mais eficiente para o processo

ensino­aprendizagem de Eletrônica Digital?

Método 1 [Avalie o nível de disposição que você tem para                   

utilizar cada um dos métodos.]
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Método 2 [Avalie o nível de disposição que você tem para                   

utilizar cada um dos métodos.]

Método 3 [Avalie o nível de disposição que você tem para                   

utilizar cada um dos métodos.]
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ANEXO A - Kit didático da DataPool Modelo 8810.
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ANEXO B - Kit de desenvolvimento ALTERA DE2-115.
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